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Working with Symbols 
and Instances8

Symbols are the building blocks of a Flash project.  This 
chapter shows you how to create symbols, store them for 

reuse in the Library, and create instances of those symbols 
on the Stage to create a Flash movie.
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Understanding Symbols and 
Instances



 A symbol is basically the blueprint of an object 
in Flash.  These blueprints are stored in the 
Library.

 When you drag a symbol from the Library to 
the Stage, you create an instance, which is the 
realization of that blueprint: An object is 
created

Understanding Symbols and 
Instances (pg 152)



Symbols
 A symbol can be a graphic, a movie clip, a 

button, a video, or a sound.  
 Each of these unique objects is used for 

different purposes.  
 You can create these symbols so that they can 

be used in your Flash movie as instances

Understanding Symbols and 
Instances  (pg 152)



Instances
 An instance is the realization of a symbol.
 You can create many instances of the same 

symbol, each with is own set of properties.
 This way, you can have several instances of the 

same symbol, which can be different colors, 
different sizes, or instances that perform 
different actions, all while coming from the 
same blueprint.

Understanding Symbols and 
Instances (pg 152)



Nesting
 Placing one symbol inside another is called 

nesting.
 A good way of thinking about nesting is to 

think of a set of Russian dolls.
 You can have symbols inside of symbols inside 

symbols, much like how the dolls are inside of 
each other.

 However, you can have more than one symbol 
at any level of nesting.

Understanding Symbols and 
Instances (pg 152)



 You can create symbols in Flash to make 
reusable graphics and animations.

 Flash has three main types of symbols: graphic, 
movie clips, and buttons.

Type of Symbols (pg 153)
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Graphic Symbols
 Graphic objects, such as those you create in 

Flash, with the drawing tools or those images 
you import, can be reused for creating 
animation in the Flash Timeline.

Type of Symbols  (pg 153)



Movie Clips
 Movie clip symbols are simply mini-movies 

that reside inside the main Flash movie file.

Types of Symbols (pg 153)



Button Symbols
 You can save interactive buttons, also called 

rollover buttons, as symbols and reuse them by 
associating different actions to the same button.

Types of Symbols (pg 153)



Other Symbols
 You can also create symbols for sound, video, 

and fonts.
 These symbols are used differently than 

graphics, buttons, and movie clips.

Types of Symbols (pg 153)



 A Flash project can contain hundreds of graphics, 
sounds, interactive buttons, video, and movie 
clips.

 The Flash Library can help you organize these 
elements

 For example, you can store related symbols in the 
same folder, create new folders, or delete folders 
and symbols you no longer need.

Using the Flash Library



 Every time you import a graphic image into a 
Flash file, convert a graphic element into a 
symbol, or add a new sound to a frame, Flash 
adds it to the file’s Flash Library .

 In effect, the Library is a compendium of your 
movie’s contents.

 You can use the Library panel to view and 
manage your movie elements.

Using the Flash Library



Open the Library Panel
1. Click Window.

2. Click Library

Using the Flash Library
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Can I use symbols from another movie’s 
Library?
Yes can easily insert symbols into your current 
project from another file’s library.
Click File, Import and then Open External 
Library.   
The Open as Library dialog box appears. Click the 
file name, and then  click Open.
The Library panel opens, listening the other file’s 
symbols. Click and drag the symbol you want to use 
onto the Stage.

Using the Flash Library



How do I place a symbol from the Library 
onto the Stage?
From the Library panel, locate the symbol you want 
to use, and then click and drag it from the Library 
and drop into onto the Stage.
The symbol is added to the Stage. You can then 
move or edit the symbol as needed, or use it in 
animation effects.

Using the Flash Library



 To organize all of you symbols, you can store 
them in folders.

 The Library folders display like any other folder 
on your computer system.

 Open the folder to view its contents or hide the 
contents and view only the folder name.

Using the Flash Library 
(continuation)



 When you open a folder, you can see every 
symbol it contains.  

 The icons next to the symbol name in the 
Library panel indicate the symbol type.

Using the Flash Library 
(continuation)
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Create a New Folder
1. Open the Library Panel

2. Click the New Folder button at 
the bottom of the Library panel.

3. Type a name for the folder.

4. Press <Enter>

Using the Flash Library 
(continuation)
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Create a New Folder
5. Click and drag the item you 

want to place in the new 
folder.

6. Release the mouse button.

Using the Flash Library 
(continuation)



How do I rename a folder?
Double-click the folder name in the Library 
panel to highlight the folder name.
Type a new name, press <Enter> and Flash 
applies the new name.
You can use this same technique to rename 
symbols in the Library window

Using the Flash Library 
(continuation)



Can I delete a folder I no longer need?
Yes, but make sure it does not contain any symbols 
you want to keep or are currently using in the file.
After you delete a folder, Flash deletes its contents, 
along with any instances you use in your animation.
To delete a folder, click it, and then click the Delete 
icon at the bottom of the Library panel.  Flash warns 
you that you are about to permanently delete the 
folder and its contents.  Click Yes and the folder is 
removed.

Using the Flash Library 
(continuation)



 You can easily turn any object you draw on the 
Flash stage, into a symbol you can reuse 
throughout your project.

 You can also convert any existing drawing or 
graphical element into a symbol.

Create a Symbol (pg 153)



 When you save an item as a symbol, Flash stores 
it in the file’s Library.

 When you reuse the symbol, you are using an 
instant or copy the original symbol.

Create a Symbol  (pg 153)



 There are three types of behaviors you can assign 
to a symbol: graphic, movie clip, or button.

 The behavior you assign depends on what you 
want to do with the symbol.

Create a Symbol (pg 153)
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 You can create graphic symbols a couple 
different ways:  directly on the Stage, and 
through the Library.

 If you create a graphic symbol and decide later 
that you need another type, you can change it in 
the Library to the appropriate symbol type.

Create a Symbol a Graphic 
Symbol  (pg 154)



Create a Graphic Symbol
1. Click and drag with the Selection tool       and 

select the artwork from which you want to 
create a symbol

2. Right-click on your selected elements and 
click Convert to Symbol from the menu.

3. Type a name for your Symbol

Create a Symbol a Graphic 
Symbol  (pg 154)



Create a Graphic Symbol
4. Choose Graphic from the Type drop-down 

menu

5. Click OK

6. Repeat steps 1-5 for the other artwork objects 
to convert

Create a Symbol a Graphic 
Symbol  (pg 154)



Create a Graphic Symbol (pg 154)
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You can click the icon 
next to Registration to 
select your symbol’s 
registration point. Each 
of the little squares is 
clickable

You can place your 
symbol in a subfolder of 
your Library by clicking 
the blue text next to 
Folder
You can see the 
advanced symbol 
creation options by 
clicking the Advanced 
option.

Create a Graphic Symbol (pg 154)



Your symbol appears in 
the Library and is ready 
to be used in your 
project

Graphic symbols are 
denoted by the Graphic 
symbol icon

Create a Graphic Symbol (pg 155)



How can I create a symbol and then add 
graphics to it?
You can add an empty symbol to the Library by 
clicking the New Symbol button at the bottom of 
the Library panel.
Then choose your symbol type, and click OK.  Flash 
automatically resets the Stage for drawing that 
symbol.  
Click Scene 1 at the top of the Stage to return to the 
main Timeline.
You can also create a new symbol by clicking Insert 
and then New Symbol.

Create a Graphic 
Symbol (pg 155)



Can I create a duplicate symbol?
Yes.  Right-click on any symbol in the Library and 
click Duplicate from the menu that appears.   
Flash prompts you as though you were creating a 
new symbol, allowing you to rename, choose a new 
symbol type, and change other options available in 
Duplicate Symbol dialog box.

Create a Graphic 
Symbol (pg 155)



 To reuse a symbol in your Flash project, you can 
place an instance of it on the Stage.

 An instance is a copy of the original symbol.
 The copy references the original instead of 

redrawing the object completely.
 This method of referencing a vector object for 

reuse is much more efficient than copying an 
object over and over again in a file.

Add an Instance of a Symbol to 
the Stage (pg 156)



 Ordinarily, when copying an object, you are 
copying the entire set of instructions that tells 
the computer how to draw the object.

 With the Flash method, the symbol instance 
merely points to the original symbol without 
needing a complete set of instruction for 
recreating the object.

 The greatly decreases the movie’s file size.

Add an Instance of a Symbol to 
the Stage (pg 156)



Insert an Instance
1. Click on the keyframe where you want to 

insert your instance.

2. Open the Library panel

3. Click and drag a symbol from the Library 
over the Stage.

4. Release the mouse button where you want 
your instance to appear on the Stage

Add an Instance of a Symbol to 
the Stage (pg 156)



Insert an Instance (pg 156)
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Note: Flash does not 
let you place an 
instance in a regular 
frame. You can only 
place instances in a 
keyframe in the 
Flash Timeline. 
Regular frames are 
reserved for tweened 
animation and the 
passage of time



Flash does not let me place an instance in 
a regular frame. Why ?
You can only place instance in a keyframe
in the Flash Timeline.
You are not allowed to place instances in 
regular frames.

Insert an Instance (pg 156)



 After you place an instance of a symbol on the 
Stage, you can change its properties without 
affecting the original symbol.

 For example, you can make your instance 
transparent, apply color effects, or scale and 
transform it.

Modify an Instances  (pg 157)



 You can change the object’s behavior by turning 
a graphic symbol into a movie clip or into a 
button.

 You can also experiment by fine-tuning an 
instance’s color effects.

 So, if you have a graphic symbol but want to use 
a blend mode, you can change the Instance to a 
movie clip in the Properties inspector.

Modify an Instances  (pg 157)



Modify an instance
1. Click the Selection tool   
2. Select the symbol
3. Open the Properties inspector.
4. Click the Style drop-down list and select 

Alpha
5. Drag the Alpha slider to affect your instance’s 

transparency.
6. Repeat steps 1-5 for other graphic symbols.

Modify an Instances  (pg 157)
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Modify an Instances  (pg 157)



4
Drag the slider to 
the left to make 
your instance 
more transparent; 
drag the slider to 
the right to make 
it more opaque

Note: To modify 
multiple instances 
at the same time, 
select the objects 
by holding down 
the shift key and 
clicking with the 
Selection tool. 
Then you can 
adjust properties 
in the Properties 
inspector for all 
the selected 
objects.

Modify an Instances  (pg 157)



How do I make the instance transparent?
To make an instance appear transparent changing its 
Alpha setting.   Follow steps 1 to 3 in this section-
“Modify an Instance”. 
Open the Advanced Effect dialog box and click and 
drag the Alpha slider to the transparency level you 
want to apply.
Click OK to apply the effect. 

Modify an Instances  (pg 157)



Can I name an instance?
You can name a movie clip or button instance and 
use the name in your action variables.
Click inside the Instance Name text box in the 
Property inspector panel and type a name.
This only works for movie clip or button instances.
You cannot name generic instances.

Modify an Instances  (pg 157)



 You can change what symbol your instances 
refer to.

 Many times, you will want to create 
placeholder buttons and simple graphics for 
your project in order to get things moving.

 Then you can simply swap them for symbols 
you create later with your polished design.

Swap Symbols (pg 158)



Swap symbols
1. Click on an instance with the Selection tool 

to select it.

2. Open the Properties inspector

3. Click Swap

4. Click the symbol you want to swap for the 
current symbol

5. Click OK

Swap Symbols (pg 158)
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You can duplicate 
the selected 
symbol by 
clicking the 
Duplicate button

A preview of the 
selected symbol 
appears.

Swap Symbols (pg 158)



The symbol is 
swapped.

Swap Symbols (pg 159)



Will I lose my color effects and filters if I swap 
symbol?
No. Changing your instance to a new symbol only 
changes the Library item that your instance refers to.
Any modifications you make to the properties of 
your instance remain.
This includes blending, color effects, filters, 
position, and size.

Swap Symbols (pg 159)



Sometimes the Swap button is grayed out. 
Sometimes it isn’t even there. Why?
The Swap button may be unavailable for a couple of 
reasons.  You cannot swap shapes.
Look at the top of the Properties inspector to make 
sure of the type of object you have selected.
You also cannot swap multiple symbols at once.
A quick way to check to see if you have multiple 
symbols selected is to look at the top of the 
Properties inspector.  If you have more than one 
symbol selected, it will say “Instance of:---”

Swap Symbols (pg 159)



 You can edit symbols you have stored in the 
Library.

 For example, you might need to change a symbol 
slightly, such as adjusting a line or shape

 You can make changes to the original symbol and 
Flash automatically updates all instances of it in 
your movie.  This can save you considerable time 
and efforts.

Edit Symbols



 You can edit symbols in Symbol Edit mode or 
in a new window.

 When in Symbol Edit mode, Flash locks the 
other objects on the Stage to prevent 
accidentally changes.  

 When you edit in a new window, only the 
symbol you want to edit appears.

Edit Symbols



Edit a symbol in symbol edit 
mode

1. Double click the symbol you want to edit

2. Edit the symbol as needed

3. Click the scene name to return to Movie Edit 
mode.

Edit Symbols



Edit a symbol in symbol edit mode
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Edit a Symbol in a New Window
1. Click Edit Symbols button

2. Click the symbol you want to edit.

3. Edit the Symbol as needed

4. Click the scene name to return to Movie Edit 
mode.

Edit Symbols



Edit a Symbol in a New Window
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How do remove a symbol no longer want?
First, make sure you do not use the symbol 
anywhere in your Flash movie.
When you delete a symbol, Flash removes any 
instances of the symbol.
Open the Library panel and select the symbol you 
want to remove.
Click        .  Note that after you delete a symbol, you 
can not undo the action.  To continue, click Delete; 
Flash permanently removes the symbol from the 
file’s Library.

Edit Symbols



Flash does not let me edit my symbol. Why 
not?
Depending on the complexity of the symbol, you 
may need to first apply the Break Apart or 
Ungroup command.
The Break Apart command breaks the symbol down 
into its most basic construction- lines and fills.
You can then edit a single line or fill.  
The Ungroup command upgroups a grouped object.  
You can find the Break Apart and Ungroup  
commands on the Modify menu.

Edit Symbols



 You can create buttons in Flash to add 
interactivity to your projects.

 Your buttons can trigger events and 
ActionScript commands

 Button symbols also have a special Timeline 
that contains specific frames for the states of the 
button: Up, Over, Down and Hit.

Create a Button Symbol (pg 160)



Create a Button Symbol
1. Click and drag with the Selection tool        

and select the artwork from which you want 
to create a button.

2. Click Modify
3. Click Convert to Symbol
4. Type a name of your button
5. Click the Type-drop-down list and choose 

Button

Create a Button Symbol (pg 160)



Create a Button Symbol
7. Click Control

8. Click Enable Simple Buttons

Create a Button Symbol (pg 160)



Create a Button Symbol (pg 160)
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Create a Button Symbol (pg 160)
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Create a Button Symbol (pg 160)

Your symbol 
appears in the 
Library and is 
ready to be used in 
your project

Button symbols are 
denoted by the 
Button symbol



I can’t move or edit my buttons, anymore. 
Why?
With Enable Simple Buttons turned on, your button 
is not selectable.  Turn off this feature by selecting 
the Control and then Enable Simple Buttons, or 
you can press <Ctrl><Alt><B> a second time.

Create a Button Symbol (pg 160)



 You can give your button a rollover effect and a 
clicked effect by editing the frames of your 
button symbol.

 Most of the time, you will want to have at least a 
rollover state so your users know your button is 
clickable

 You also want a Hit state so Flash knows when 
the mouse is within the bounds of your button.

Edit the States of a Button (pg 162)



Edit the States of a Button
1. Double-click your instance to edit it in place.

2. Open the Timeline panel

3. Select all frames of the button Timeline

4. Right-click on the selected frames and click 
Convert to Keyframes

Edit the States of a Button (pg 162)



Edit the States of a Button

1

2 3

4

This area indicates 
that you are editing 
the button’s 
Timeline

Edit the States of a Button (pg 162)



Edit the States of a Button
5. Click the Over frame in the Timeline.

6. Edit your button’s elements with the Flash 
drawing tools

Edit the States of a Button (pg 162)



Edit the States of a Button

This frame called 
Over becomes 
what is shown 
when a user moves 
the mouse pointer 
over the button

5

6

The selected 
frames are now 
keyframes.

Edit the States of a Button (pg 162)



Edit the States of a Button
7. Click the Down frame in the Timeline.

8. Edit your button’s elements with the Flash 
drawing tools.

Edit the States of a Button (pg 163)



Edit the States of a Button

This frame called 
Down becomes 
what is shown 
when a user clicks 
the button

7

8

Edit the States of a Button (pg 163)



My button doesn’t have Up, Over, Down, 
and Hit frames, but the Properties 
inspector say it is a button. Why?
If you place a graphic or movie clip symbol on the 
Stage and then cast it as button in the Properties 
inspector, it will have simple numbered frames.
Remember, when you edit a Symbol you are editing 
the blueprint for your object and not just modifying 
an instance.
In another symbol type cast as a button, frame 1 
corresponds to Up, frame 2 to Over, frame 3 to 
Down and frame 4 to Hit.

Edit the States of a Button 
(pg 163)



 Your button will function without editing the 
states.

 However, rollover effects, and down states make 
for much more rich interaction.

Edit the States of a Button  
continuation   (pg 164)



Edit the States of a Button
9. Click the Hit frame in the Timeline

10. Click the Rectangle tool

11. Click and drag to draw a rectangle around 
your button.

12. Click the Scene 1 button

Edit the States of a Button  
continuation   (pg 164)



Edit the States of a Button

9
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This  Hit frame 
is not shown in 
Flash.  It simply 
denotes the Hit 
area of the your 
button.

Edit the States of a Button  
continuation   (pg 164)



Why do I need to edit the Hit state?
As a general rule, it is good to always edit the Hit 
state of your buttons.
A common beginner’s mistake in Flash is to create a 
button that is made up of text with no background 
and not have a solid Hit state.
By doing so, users must move their mouse over the 
actual lines of the letters in order to click the button.

Edit the States of a Button  
continuation   (pg 164)



 You can use the Behaviors panel to add simple 
actions to your button without the need to learn 
how to write ActionScript.

 Behaviors are a simplified way of adding 
interactivity to your Flash projects.

Add a Behavior to a Button  
(pg 166)



 It is important to note that behaviors only work 
in Flash movies using ActionScript 2.0 or lower.

 You must adjust your publish settings 
accordingly in order to use behaviors.

 And, you must be careful to not use any 
ActionScript 3.0 commands or functionality.

Add a Behavior to a Button  
(pg 166)



Add a Behavior to a Button
1. Place an instance of a button symbol on the 

Stage.

2. Click Window

3. Click Behaviors

4. Click the Add menu icon button

5. Click Web

6. Click Web page

Add a Behavior to a Button  
(pg 166)



Add a Behavior to a Button
7. Type a Web site URL

8. Click OK

9. Press <Ctrl><Enter> to test your movie

10. Click your button

Add a Behavior to a Button  
(pg 167)



How do I delete a behavior?
You can delete a behavior by opening the Behaviors 
panel, clicking on the behavior you want to remove, 
and then clicking the Delete Behavior button.

Add a Behavior to a Button  
(pg 167)



How do edit a behavior?
Double-click on the name of the behavior you want 
to edit in the Action column of the Behaviors panel.
Depending on the type of behavior you selected, a 
dialog box appears that allows you to adjust your 
settings.

Add a Behavior to a Button  
(pg 167)



 You can create movie clips that contain graphics 
and animation. 

 Movie clip symbols are more powerful than 
graphic symbols because you can give them 
instance names that allows them to be controlled 
by ActionScript.

Create a Movie Clip Symbol 
(pg 167)



Create a Movie Clip Symbol
1. Open the Library panel.

2. Click the New Symbol button

3. Click here and type a name for your movie 
clip.

4. Click the Type drop-down list and select 
Movie Clip

5. Click OK

Create a Movie Clip Symbol 
(pg 167)



Create a Movie Clip Symbol
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Create a Movie Clip Symbol 
(pg 167)



Create a Movie Clip Symbol
6. Add elements to your movie clip with the 

Flash drawing tools.

7. Click the Scene 1 button to return to the main 
Timeline.

8. Click on the frame where movie clip will be 
inserted onto the layer.

9. Click and drag an instance of your new movie 
clip from the Library onto the Stage

Create a Movie Clip Symbol 
(pg 167)



Create a Movie Clip Symbol

6

Create a Movie Clip Symbol 
(pg 167)



Create a Movie Clip Symbol

7

9

Your new movie 
clip appears on the 
Stage

8

Create a Movie Clip Symbol 
(pg 167)



Add instance of a movie clip
1. Click on the frame where the instance of the 

movie clip symbol will be inserted onto the 
layer.

2. Click and drag an instance of your new movie 
clip from the Library onto the Stage

3. Repeat steps 1- 2 for other movie clip

Create a Movie Clip Symbol 
(pg 169)



Add instance of a movie clip

2

1

Your movie clip 
appears on the 
Stage

Create a Movie Clip Symbol 
(pg 169)



Add instance of a movie clip

2

1

Your movie clip 
appears on the 
Stage

Create a Movie Clip Symbol 
(pg 169)



Can I create a symbol from elements 
already on the Stage?
Yes.  There are two ways to create a symbol.  One 
way is to use the New Symbol button in the Library, 
as described in this section.
The other way is to use the Convert to Symbol menu 
item as described in the section “Create a Graphic 
Symbol”.

Create a Movie Clip 
Symbol (pg 169)



Does using movie clips instead of graphics 
increase my file size?
Movie clips have a little more overhead than 
graphics do when exported in Flash movies.
Most of the time, however, the difference is 
negligible.
If you are concerned about your file’s size, it is more 
prudent to change your bitmap and sound 
compression settings.

Create a Movie Clip 
Symbol (pg 169)



 You can use the Library to play through your 
symbols so you can better identify them.

 Sometimes, symbols do not include any graphics 
on the first frame.

 For example, a picture that fades in is invisible 
on the Stage and does not show a preview in the 
Library.

 Or, you may have a sound symbol that does not 
have a very descriptive name.

Preview a Symbol (pg 170)



Preview a Symbol
1. Open the Library panel

2. Click the symbol you want to preview

3. Click play button

4. Click         to stop the preview

Preview a Symbol  (pg 170)



Preview a Symbol

Preview a Symbol (pg 170)
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Flash plays through all 
the frames of the 
symbol in the preview 
area.



Preview a Symbol on the Stage
1. Open the Library panel.

2. Double click the symbol you want to preview.

3. Open the Timeline panel

4. Click frame 1 on your movie clip.

5. Click Control

6. Click Play

Preview a Symbol  (pg 171)



Preview a Symbol on the Stage

Preview a Symbol (pg 171)
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press <Enter>. 
Your movie clip 
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How do stop the preview from playing on 
the Timeline?
You can simply press <Enter> again and the play 
head stops.  You can also click Window, Toolbars, 
and then Controller, which displays a panel with 
DVD player-style controls for your Timeline.

Preview a Symbol (pg 171)



 You can add drop shadows, glows, blurs, and 
bevels to your button and movie clip instances.

 Using filters can be a good way to save file size 
by reducing the number of imported graphics 
you need.

Apply Filters to an Instance           
(pg 172)



Add a drop shadow filter
1. Click a movie clip or button symbol on the 

Stage with the Selection tool

2. Open the Properties inspector.

3. If it isn’t already expanded, click Filters

4. Click the Add Filter button

5. In the menu that appears, click Drop Shadow

Apply Filters to an Instance           
(pg 172)



Add a drop shadow filter
6. Click and drag the Distance setting until it 

has a value you like.  

Apply Filters to an Instance           
(pg 172)



Add a drop shadow filter
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Apply Filters to an Instance           
(pg 172)



Add a drop shadow filter

6
You can also adjust 
other values of the 
filter.

Apply Filters to an Instance           
(pg 172)



Adjust Color
1. Click the Add Filter button 

2. In the menu that appears, click Adjust Color

3. Click Hue setting

4. Type a value between – 180 and 180.

Apply Filters to an Instance           
(pg 173)



Adjust Color

21

3 Flash renders the 
blend mode on the 
Stage.

Apply Filters to an Instance           
(pg 173)



How many filters can I have?
You can add as many filters as you want.  In fact, 
you can have multiple versions of the same filter.
For example, you can have a black drop shadow and 
a red drop shadow, or multiple gradient glows.

Apply Filters to an Instance           
(pg 173)



What does the Quality filter setting do?
Sometimes, depending on the power of your 
computer and graphics card, animation my stutter 
when using high-quality filters.
If you pan on distributing your Flash project over 
the Web, considering using medium or low quality 
to accommodate those with less than optimal 
computers.

Apply Filters to an Instance           
(pg 173)



 You can use blend modes that are very similar to 
those in Adobe Photoshop in Flash.

 Blend modes allow you to create transparency 
effects like darken, multiple, hard light, screen 
overlay, and others.

 Many times you will not know which blend 
mode you want until you see it.

Apply a Blend Mode to an 
Instance (pg 174)



Apply a Blend Mode to an 
Instance

1. Click a movie clip or button instance on the 
Stage with the Selection tool.

2. Open the Properties inspector.

3. If it isn’t already open, click Display in the 
Properties panel.

4. Click the Blending drop-down

5. Click Multiply

Apply a Blend Mode to an 
Instance (pg 174)



Apply a Blend Mode to an Instance

Apply a Blend Mode to an 
Instance (pg 174)
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Understanding the Difference 
Blend Modes (pg 175)

Normal- This mode indicates that no blending is applied

Layer- This blend mode makes your symbol behave as though 
it is a single image, regardless of its subcomponents.

Darken- This blend mode shows the darkest color per pixel

Multiply- This blend mode multiplies the color values. The 
result is usually darker.

Lighten- This blend mode replaces colors if they are lighter.

Screen- This blend mode multiplies the inverse of the blend 
and base colors.

Overlay- This blend mode darkens dark colors like multiply 
and lightens light colors.



Understanding the Difference 
Blend Modes (pg 175)

Hard Light - This blend mode colors lighter than gray will 
screen, colors darker than gray will multiply.

Add - This blend mode adds the color values together, usually 
resulting in an increase in brightness.

Subtract - This blend mode subtracts color values from one 
another, usually resulting in a decrease in brightness

Difference - This blend mode subtracts the less bright color 
from the brighter color

Invert - This blends mode simply inverts the colors of 
anything underneath

Alpha - This blends mode extracts the alpha (transparency) 
value and applies it to the objects underneath



Understanding the Difference 
Blend Modes (pg 175)

Erase - This blend mode inverts the alpha before applying it to 
the objects underneath



 If you are familiar with other applications with 
3-D capabilities, it is important to note that 
Flash does not do depth buffering.

 Basically, that means that object that intersect in 
3-D space do not follow the rules of 3-D, but 
follow the rules of layers and arrangement.

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 176)



 Flash CS5 has new toolset for rotating and 
translating movie clip objects in three 
dimensional space.

 To translate an object is simply to move it to a 
new set of coordinates.  

 You can use these tools to create realistic-
looking 3-D effects.

 Your publish settings must target ActionScript 3 
to use the 3-D tools

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 176)



Rotate in 3-D
1. Click the 3D Rotation tool

2. Click a MovieClip instance on the Stage.

3. Open the Properties inspector

4. Click the blue number next to the Camera 
icon and set the perspective angle value of 
140.

5. Click and drag the red line which is the free-
form 3-D rotation, and change the 
perspective of your movie clip

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 176)



Rotate in 3-D
The red line 
represents the X-axis.
The green line 
represents the Y-axis
The blue circle 
represents the Z-axis
The orange circle is 
the free-form 3-D 
rotation

1

2

3

4

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 176)



Rotate in 3-D
The red line 
represents the X-axis.
The green line 
represents the Y-axis
The blue circle 
represents the Z-axis
The orange circle is 
the free-form 3-D 
rotation5

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 176)



Translate in 3-D
1. Click on the 3-D Translation tool  

2. Click a movie clip to select it

3. Click and drag the green arrow to move your 
movie clip upward in 3-D space.

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 177)



Translate in 3-D
The red arrow 
represents the X-axis.
The green arrow 
represents the Y-axis
The blue dot 
represents the Z-axis
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I can’t get my movie clip back to its 
original position and rotation. How can I?
A quick trick to reset your translation and 3-D 
rotation is to open the Properties inspector, and click 
the top-most-drop-down menu, where Movie Clip is 
currently selected.
Then click Graphic to cast your instance as a 
graphic.
The resets your 3-D position and view because 
graphic instances cannot be moved in 3-D.  Then, 
cast your instance as a movie clip again to start over.

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 177)



When I change my camera, it modifies 
every 3-D movie clip.  Why?
You can only have one camera in Flash.
So any time you modify the perspective angle it 
affects all of your 3-D objects.

Rotate and Translate MovieClips 
Instances with 3-D Tools (pg 177)


